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Introduction 

We Thank You 
Vertigraph seeks to provide takeoff and estimating tools that increase your profits 
and productivity.  In addition to BidPoint XL, our other software solutions include: 

• BidScreen XL - eTakeoff of ePlans in Excel 

• BidData XL -  an open, database add-in for MS Excel 

• SiteWorx – calculates cut and fill quantities for site excavation  

• BidWorx – our high level assembly, relational database estimating 
software  

We also supply hardware such as scanners, printers and digitizer tablets.  

Our guiding principles are: 

• Quality, integrity and value are our highest concerns. 

• Customers are the reason we exist. 

Minimum System Requirements 
BidPoint XL requires: 

• Windows 2000, XP or Vista operating system. 

• Microsoft Excel version 97 or later. 

• A digitizer tablet. 

The digitizer tablet requires: 

• An available serial port or USB port on your computer.  If you look on 
the back of your computer, the serial port is usually a 9 pin male 
connection.  If you have an older GTCO/CalComp brand digitizer that 
doesn’t have a USB cable, an optional USB to serial port converter is 
available. 

• The appropriate 32-bit Wintab driver (GTCO/CalComp TabletWorks or 
Numonic’s Virtual Tablet driver) for your Windows operating system.  
The digitizer manufacturer supplies the Wintab driver.   
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BidPoint XL License Agreement 
Vertigraph, Inc.  Program License 12959 Jupiter Road, Suite 252 Dallas, TX 75238 

Carefully read the following terms and conditions before using the program.  Use of 
the program indicates your acknowledgment that you have read this license, 
understand it, and agree to be bound by its terms and conditions. 

Vertigraph, Inc. ("Licensor") grants to the purchaser of the BidPoint XL Software 
License ("Licensee") a non transferable license to use BidPoint XL ("Licensed 
Software").  Use of the Licensed Software is limited to a single digitizer tablet 
connected to a single computer.  Your right to use the Licensed Software terminates 
upon the violation of any provision of this License.  The Licensed Software is the 
BidPoint XL computer program which includes, without limitation, any form of the 
programs, copies, modifications, enhancements, revisions and updates thereof, 
source code, sample workbook(s), utility programs, visual/written materials and any 
other documentation.  Until you obtain a registration number from Licensor, you 
agree that the BidPoint XL software is used for the purpose of evaluating the 
software only and not for the production of income.  Licensee may not decompile the 
Licensed Software from object code to source code or crosscompile or otherwise 
adopt or modify the Programs.  You agree to take all necessary steps to ensure that 
the provisions of this License are not violated by you or any person under your 
control or in your service.  You may transfer the Licensed Software to a single hard 
disk.  Licensor shall have sole and exclusive ownership of all rights, title and interest 
in and to the Licensed Software and all modifications and enhancements thereof 
(including ownership of all trade secrets and copyrights pertaining thereto).  This 
agreement does not provide Licensee with title or ownership of the Licensed 
Program, but only a right of use.  You may not copy, allow anyone else to copy, or 
otherwise reproduce any part of the Licensed Software and/or documentation 
without Vertigraph's written consent. 

Disclaimer and Limitation of Liability: Due to the complex nature of computer 
software, Vertigraph, Inc. does not warrant that the Licensed Software is completely 
error free, will operate without interruption, or is compatible with all equipment or 
software configurations. 

Neither Vertigraph, Inc. nor anyone else who has been involved in the creation, 
production or delivery of the programs or documentation shall be liable to you for 
any damages of any type, including but not limited to, any lost profits, lost savings, 
loss of anticipated benefits, or other incidental or consequential damages arising out 
of contract, negligence, or under any warranty even if Vertigraph, Inc. has been 
advised of the possibility of such damages or for any other claim by any other party.  
Vertigraph's liability for damages in no event shall exceed the licensee fee paid for 
the right to use the licensed software. 

Vertigraph, Inc. Provides the licensed software "as is" without warranty of any kind, 
either express or implied, including but not limited to, the implied warranties of 
merchantability or fitness for any particular purpose.  Furthermore, Vertigraph, Inc. 
reserves the right to revise the Licensed Software and documentation and to make 
changes from time to time to the content thereof without obligation of Vertigraph, 
Inc. to notify any person of such revision or changes.  Some states do not allow 
disclaimer of express or implied warranties in certain transactions; therefore, this 
statement may not apply to you. 

The documentation could include technical inaccuracies or typographical errors.  
Changes are periodically made to the information; these changes will be incorporated 
in new editions of the publication.  Vertigraph, Inc. may make improvements and/or 
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changes in the Licensed Software and/or the program(s) described in this publication 
at any time. 

The agents, distributors, employees and dealers of Vertigraph are not authorized to 
modify this Agreement or to make statements, representations or terms binding 
Vertigraph, Inc.  Accordingly, any statements, representations or terms not made or 
given directly or expressly by Vertigraph are not binding on Vertigraph, Inc. 

It is agreed that the laws of the State of Texas shall govern this Agreement. 

Copyright - This program and related documentation is the confidential and 
proprietary product of Vertigraph, Inc.  Any unauthorized use, reproduction or 
transfer of this program and/or documentation is strictly prohibited and subject to 
criminal prosecution.  Copyright 1999-2007 by Vertigraph, Inc.  All rights reserved. 

Installing BidPoint XL and the Digitizer Toolbar 
BidPoint XL Version 4 enables you to digitize quantities from paper plans into any 
MS Excel workbook. The quantity along with the digitized drawing is saved with the 
Excel cell and file.  Each workbook cell may contain a different takeoff quantity and 
digitized drawing.  A selection of digitized drawings may be included on one, scaled 
printout.   
 

To operate BidPoint XL properly please note: 

1. The digitizer driver must be installed.  This digitizer driver is available from 
the digitizer tablet manufacturer.  If installed properly, you will be able to 
control the mouse pointer with the digitizer pointing device.  See Hooking 
up your Digitizer for additional information about the digitizer driver 
software. 

2. Add BidPoint XL to your Microsoft Excel application.  To add BidPoint XL 
the pre Excel 2007 version, open Excel and click on the Tools | Add-Ins 
menu and press the Browse button to select the BidPointXL.xla add-in file.  
If you installed BidPoint XL to the default directory, this BidPointXL.xla 
file will be found in the C:\Program Files\Vertigraph\BidPoint XL folder.  
After installing you’ll have a digitizer menu and toolbar added to the Excel 
application.  Under MS Excel version 2007 or later, you’ll click on the 
Add-Ins menu and then right click on the Office Button in the top left 
corner of the window. Next you’ll select the Customize Quick Access 
Toolbar and then select the Add-ins option.  At the Add-ins window, click 
the Go… button at the bottom of the window to browse for the 
BidScreenXL.xla add-in file.  This BidScreenXL.xla will be located at 
C:\Program Files\Vertigraph\BidPoint XL folder. 

3. Prior to digitizing in Excel, you must define the actions associated with the 
buttons on your digitizer pointing device. Open the Digitizer Setup dialog 
by clicking on the Digitizer | Setup menu on the Excel menu bar or Add-
ins menu. Then select Setup. Select the Cursor Style tab and select your 
cursor type from the list. Press the "Set button actions to recommended 
values" button, then press "OK."  You are now ready to digitize. 

Sample Excel estimating files can be found at C:\Documents and Settings\All 
Users\Documents\Vertigraph\BidPoint XL\examples if you installed BidPoint XL 
under the Windows XP operating system.  If you installed BidPoint under Windows 
Vista these sample Excel files are found at C:\Users\Public\Public 
Documents\Vertigraph\BidPoint XL\examples.  Please use and modify these Excel 
files in any way you desire . 
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PDF documents of the recommended button setup and other information are found at  
C:\Program Files\Vertigraph\BidPoint XL\PDF. 

Note:  Menu and button commands are listed in bold throughout this guide.  Sub-
menus are displayed after a vertical line.  For example, the Area command under the 
Digitizer menu is shown as Digitizer | Area.   

To install the files from the compact disc to your hard drive, select BidPoint XL 
from the Vertigraph install menu or perform the following: 

1. Click the Windows Start button. 

2. Select Run. 

3. Enter or browse for D:\BIDPOINT XL\BidPoint_Setup.exe or 
D:\AUTORUN.EXE.  The above command assumes the compact disc drive is 
your D drive; change the drive letter to the appropriate drive if this is not the 
case. 

4. The Setup program will now start.  Just follow the on-screen instructions to 
install.   

Note: If you downloaded the BidPoint evaluation file from www.vertigraph.com 
simply run the BidPoint_Setup.exe file to install the BidPoint XL application to your 
hard drive. 

To add BidPoint XL to Microsoft Excel perform the following: 

a) After installing the software to your hard drive, open Microsoft Excel (pre Excel 
2007 version) and click on the Tools menu.  Next select Add-Ins and click on 
the Browse button to find the BidPointXL.xla file.  If you installed BidPoint XL 
to the default directory, this BidPointXL.xla file will be located at the 
C:\Program Files\Vertigraph\BidPoint XL folder.  After finding the 
BidPointXL.xla file at the browse window, highlight the file name and select the 
OK button. This will add BidPointXL to the list of Add-Ins.  Make sure 
BidPointXL is checked on the Add-Ins list and click the OK button.  You’ll 
know BidPoint XL is added correctly if the Digitizer menu option is added to 
the Excel menu bar.   The installation is a little different when adding BidPoint 
XL to Excel version 2007 or later.  Under Excel 2007 or later, click on the Add-
Ins menu and then right click on the Office button found on the top left corner 
of the window.  After right clicking on the Office button, select the Customize 
Quick Access Toolbar and then select the Add-ins option.  At the Add-in 
window, click the Go… button at the bottom of the page to Browse for the 
BidPoint XL.xla file.  This BidPointXL.xla file is located at C:\Program 
Files\Vertigraph\BidScreen XL folder. 

b) If the Digitizer toolbar is not displayed, add the Digitizer toolbar to Excel by 
clicking on View | Toolbars and check Digitizer. 

To uninstall BidPoint XL perform the following in Excel: 

• Click on Tools | Add-Ins – uncheck BidPointXL. 

• After removing BidPoint from Excel, remove the BidPoint XL software by 
selecting Uninstall BidPoint XL from BidPoint XL on the All Programs Listing.     

Hooking up your Digitizer 
BidPoint XL requires a digitizer tablet with the appropriate Wintab driver installed 
on the computer.  The Wintab driver is software supplied by the digitizer 
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manufacturer.  The digitizer pointer will move the mouse pointer and operate like a 
mouse when the Wintab driver is installed properly.   

GTCO/CalComp calls their Wintab driver the TabletWorks driver.  The Numonic’s 
Wintab driver is called the Virtual Tablet Driver.   Different operating systems 
require different drivers.  As a result, we recommend that you install the latest, most 
current version of the Wintab driver on your computer.  The GTCO/CalComp drivers 
are available at http://www.gtcocalcomp.com/supportgtcosoftware.htm.  Before 
installing the latest driver, always uninstall your current driver by removing the 
software through the Add/Remove Programs icon on your Control Panel. 

 For additional help in installing the Wintab driver, please contact Vertigraph or the 
digitizer manufacturer. 

Please note that the Wintab driver should be configured to operate in relative (i.e. 
mouse) mode, rather than absolute, tracking mode.  The GTCO/CalComp Wintab 
driver should have Mouse and Wintab checked at the top of the TabletWorks dialog 
box.  

When the Wintab driver is installed properly, you’ll be able to control all Windows 
programs using the digitizer-pointing device.  Additionally, one of the buttons on the 
pointing device should operate as a left mouse click and a different button should 
operate as a right mouse click.  If you’re unable to move the mouse pointer with the 
digitizer-pointing device, double-check the following: 

• Is the digitizer plugged in and turned on? 

• Is the cable connected between the computer and the digitizer? 

• Is the digitizer recognizing the pointing device?  Many pointing devices 
have a light that stays lit when the digitizer recognizes the pointing device. 

• Is the correct Wintab loaded?  A different 32 bit Wintab driver may be need 
based on your Windows operating system.   

• Is the digitizer configured with the correct Wintab "settings"?  The Wintab 
driver requires digitizer settings of 9600 baud, 8 data bits, 1 stop bit, no 
parity and high-resolution binary output.  You can configure the GTCO 
digitizer by using the superset code of S01.  To set the superset code to S01, 
click on the S, 0 then 1 key on the digitizer surface using either the tip of 
the digitizer stylus pen or top left button on the sixteen button cursor.   

• Is the correct serial (i.e. com) port specified?  You can check the com port 
used by Wintab by clicking on the Windows Start button and then going to 
Settings | Control Panel and then clicking on the digitizer icon to 
determine the COM (i.e. serial) port setting.   

• Have you uninstalled the previously installed Wintab driver, prior to 
installing the latest Wintab driver?  Always un-install the existing Wintab 
driver before installing the new version. 

If the above questions are answered yes, please contact Vertigraph or the digitizer 
manufacturer for further assistance.   

For more information, see Getting Technical Support. 

How to Register BidPoint XL 
After purchasing the BidPoint XL software license, you are considered a registered 
user and entitled to use, rather than just evaluate, the software.  Until you obtain a 
registration number, you agree that the BidPoint XL software is used for the purpose 
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of evaluating the software and not for the production of income.  If your copy of 
BidPoint XL is not registered, a dialog box appears when starting Excel that states 
"Evaluation copy, would you like to register?"  To register, click on Yes and call 
Vertigraph, Inc. at 800-989-4243 to obtain your registration number. 

Getting Technical Support 
If you need assistance, contact Vertigraph by: 

• Internet address www.vertigraph.com 

• Telefax at (214) 340-9437 

• E-Mail addressed to technical support at info@vertigraph.com 

• Mail addressed to Vertigraph Technical Support, 12959 Jupiter Road, Suite 
252 Dallas, TX 75238 

• Telephone (214) 340-9436 between 8:30 a.m. and 5:30 p.m., Central Time. 

For your reference, telephone numbers and web addresses of the major digitizer 
manufacturers are:  

• Numonics Corporation - 800-247-4517, www.numonics.com 

• GTCO/CalComp Corporation - 800-344-4723 , www.gtcocalcomp.com 

BidPoint XL, the Digitizer and Microsoft Excel together 
BidPoint XL provides estimators and quantity surveyors with an easy to use tool that 
measures items from construction drawings and places the measurement and the 
associated digitized drawing into a Microsoft Excel spreadsheet cell.  The estimator 
will develop the takeoff in Microsoft Excel and use BidPoint XL with a digitizer 
tablet to quickly measure areas, lengths and counts from the drawings.  You’ll need 
Microsoft Excel and a digitizer tablet with the correct Wintab driver loaded to 
operate BidPoint XL. 

BidPoint XL enables you to: 

• Electronically measure areas, lengths, and counts. 

• Accumulate areas and continuous lines. 

• Subtract islands from digitized areas. 

• Automatically calculate the drawing scale. 

• Calculate perimeter lengths as you measure areas. 

• Set line styles, line widths, count symbols and area fill patterns.  

• Assign a variety of colors to the digitized drawing lines. 

• Edit and save the digitized drawing. 

• Select which combination of digitized drawings to include on a printout. 

• Set the digitizer cursor/stylus buttons to perform various digitizing actions. 

• Associate a unique sound to the digitizing action. 

• Select English or Metric scale units. 



BidPoint XL Users' Guide Introduction  •  7 

• Measure the area and circumference of a circle by clicking on three points 
along the perimeter. 

• Measure the area and perimeter length of a rectangle by clicking on three 
points clockwise or counterclockwise. 

• Draw arcs by clicking on two points after an initial point is entered. 

• Delete any selected object. 

• Use the digitizer pointing device buttons to select digitizer commands and 
Wintab macros.  

Prior to digitizing areas, lengths and counts for the first time, you’ll need to install 
the Wintab driver and setup the digitizer buttons by going to Digitizer | Setup. 

What is New with this Version of BidPoint XL 
For current users of BidPoint XL, this latest version includes the following 
enhancements: 

• Ability to delete selected objects. 

• Digitized line characteristics may be defined through the use of Styles. 

• The Style legend may be included with any printouts. 

• Improved print features with the ability to rotate the image and select the 
desired print scale.  The print title block information is now automatically 
saved. 

• Individual area and length measurements may now be included on any 
printout.  

• Change the drawing scale at any time.  

• Ability to measure areas and perimeters of rectangles by entering three 
points instead of the previous required five points. 

• Ability to measure the area and circumference of circles by entering three 
points instead of tracing. 

• Ability to measure and draw arcs by entering a high and low point instead 
of tracing. 

• Macros can be assigned to the digitizer buttons through the Wintab driver to 
initiate measurements under Windows XP.   

• Ability to assign digitizer buttons for arc, circle and rectangle 
measurements. 

• Ability to assign a digitizer button to activate a popup menu that allows you 
delete objects, measure arcs, circles and rectangles, access style settings, 
close areas, end lines and stop the takeoff.  The popup menu can be applied 
to a button on the cursor or pen stylus. 

• Status messages are now displayed as you digitize.    





BidPoint XL Users' Guide Digitizer Menu and Toolbar  •  9 

Digitizer Menu and Toolbar 

Introduction 
 The BidPoint XL digitizer commands are performed through Microsoft Excel by 

making selections from either the Digitizer menu or by clicking on commands found 
on the Digitizer toolbar.  Sample Excel files are included with BidPoint XL.  These 
sample files are found at C:\Documents and Settings\All 
Users\Documents\Vertigraph\BidPoint XL\examples if you installed BidPoint XL 
under Windows XP.  If you installed BidPoint XL under Windows Vista or later, 
these sample Excel files are located at C:\Users\Pubic\Public 
Documents\Vertigraph\BidPoint XL\examples.  Please use and modify these sample 
Excel files as you see fit. 

BidPoint XL is an Excel add-in program that must be added to Excel by opening 
Microsoft Excel (pre Excel 2007) and then clicking on the Tools menu option.  Next 
select Add-Ins and press the Browse button to find the BidPointXL.xla file.  If you 
installed BidPoint XL to the default directory, this BidPointXL.xla file will be at the 
C:\Program Files\Vertigraph\BidPoint XL folder. 

If you are adding BidPoint XL to Excel 2007 or later, click on the Add-ins menu and 
then right click on the Office button found in the top left corner of the window.  
After right clicking on the Office button, select Customize Quick Access Toolbar 
and then select the Add-ins option.  At the Add-ins window, click the Go… button 
at the bottom of the window and then browse for the BidPointXl.xla file.  This 
BidPointXL.xla file will be at the C:\Program Files\Vertigraph\BidPoint XL folder   

The Digitizer toolbar is displayed in Microsoft Excel by selecting View | Toolbars 
and then clicking on Digitizer.  A check mark next to Digitizer indicates the toolbar 
is displayed. 

The toolbar is shown below: 

 
By placing your mouse pointer over the icon, a popup description of the icon 
appears. 

The Digitizer menu has the same commands: 
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Before using the digitizer, you'll need to setup the digitizer buttons.  For more 
information see 

Change Drawing 

Count 

Section Length 

Continuous Length 

Area 

Print Drawing 

Setup 

Change Drawing 

 

The change drawing dialog box appears after selecting Digitizer | Change Drawing 
or by clicking on the Change Drawing tool on the toolbar. 
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If you are not using Drawing Names as noted at Digitizer | Setup, the Change 
Drawing dialog is where you set the drawing scale.   

If you are using Drawing Names as noted at Digitizer | Setup, you’ll also create new 
drawing names and select from the Drawing name list.  Each named drawing may 
contain settings for default style and rounding.  If you use drawing names you’re also 
be able to register the drawing.  The register drawing tab allows you to digitize two 
points on the drawing to set the registration.  Once a drawing is registered, you’re 
able to move the drawing on the digitizer tablet and then by re-registering the 
drawing, you’ll line up the digitized measurements to the drawing on the digitizer.  

All measurements digitized with BidPoint XL require a scale.  When first setting the 
scale, BidPoint XL prompts you for the scale units.  A workbook can use either an 
English or Metric scale.  English returns square feet for area measurements and 
lineal feet for lengths.  Metric returns areas in square meters and lengths in lineal 
meters.  

The look of the scale dialog depends on whether English or Metric scale units were 
chosen when creating the workbook.  The English scale dialog has an option for both 
architectural and engineering scales.   

There are three ways to set the scale.  You can select a scale from a drop down list 
box by clicking on the down arrow.  Alternatively, you can automatically calculate 
the scale by clicking on the yellow ruler button.  You’ll then digitize the beginning 
and end points of a line and then enter the length of the line.  When setting the scale 
with the digitizer, you should try to digitize the longest line with a known length.  
The third way to set the scale is by clicking on the Manual button and manually 
entering the drawing scale.  After setting the scale, you can begin digitizing areas, 
lengths and counts. 

The current scale used in digitizing the selected cell is displayed on the toolbar 
shown below. 

 

Please note the following:  
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a)  Although a scale is displayed, the scale factor is what is truly used in calculating 
measurements.  The scale factor for English units is calculated as the reciprocal of 
the scale times 12.  For example, if the scale is 1/8", the scale factor is 96 (i.e. 
((8/1)*12)).  The scale factor for Metric units is equal to the reciprocal of the scale. 

b)  If the scale factor was calculated by digitizing a line and entering a length, a scale 
will be displayed if the calculated scale is within 10% of one of the scales on the list.  
If the calculated scale is not close to one on the scales found on the list, BidPoint XL 
will display "Nonstandard" on the Current Scale button.  As a result, if Nonstandard 
is displayed, you know you are using a calculated scale.  If a scale is displayed, 1/8" 
for example, and the scale factor is 96 (reciprocal of 1/8 times 12) then the scale was 
most likely selected from the list and you are using a true 1/8" scale factor.  If 1/8" 
scale is displayed but the scale factor is not 96, then the scale was calculated by 
entering the length of a digitized line. 

c)  Once a drawing has been digitized, you're unable to change the scale unless you 
select the Digitizer | Change Scale command for the select cell(s). 

Count 

 

To digitize count items, click on a spreadsheet cell and choose Digitizer | Count or 
click on the Count button on the toolbar.   

Once you select the command, the Digitizer Control (Count) window appears. 

At the Digitizer Control window, simply click either the pen tip or top-left cursor 
button on the plan every time that you want to record a count item.  If you make a 
mistake, hit the Backspace key to delete the last item.  You can also delete any item 
by selecting the Delete Selected Object command from either the popup menu set 
under Digitizer | Setup Buttons or by using the Edit menu of the digitizer control 
window. When you’re done, click the button on the digitizer pen or cursor that you 
set as the stop digitizing action under Digitizer | Setup Buttons, press the End key 
on the keyboard or click the green check mark using your mouse to close the window 
and record the number into Excel. 

You’ll notice that the Digitizer Control screen has four menu options: File, Edit, 
Options and Help.  To access these menu options, use the mouse, popup menu or 
keyboard hot keys (Alt + the underlined letter).  You can use the digitizer to select 
these options if you press the button you defined as the popup menu or the button 
defined as suspend at Digitizer | Setup buttons.  To turn the pointing-device back 
into digitizing mode after pressing the suspend button, click on the Return to 
Measuring icon (it looks like a lightning bolt) found at the Measure display.   

To change the count symbol and color of the digitized measurement, click on the 
Style button and select a color and point symbol.  You can also select the color and 
point style by selecting the Options menu. 

Note: You can also change the color of the drawing lines by changing the font color 
in Excel.  
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Section Length 

 

Section Length is used when the lengths you’re taking off are not connected.  
Lengths of walls and roof valleys are examples of lengths you would takeoff in 
sections.  

To digitize section lengths, click on a cell, and then choose Digitizer | Section 
Length or click on the Section Length icon on the toolbar. 

When digitizing section lengths, you must click at the beginning and end of every 
line.  Every time you press down on the digitizer you’ll be recording either the 
beginning or end of the section line.  If you have two section lines connected at a 
corner, you’ll need to click on the corner twice in a row, once to end the first line and 
again to start the next line.  While digitizing, you can determine if you’re at the 
beginning or end of the section line by looking at the count value in the Digitizer 
Control (Section Length) window.  When the value is an even number, the next point 
you hit is the beginning of the next section.  If the count is an odd number, the next 
point you hit will end the section line.   

Again, if you make a mistake, hit the Backspace key to delete the last point.  You 
can also delete specific lines by selecting the Delete Selected Object command from 
either the popup menu set under Digitizer | Setup Buttons or by using the Edit 
menu of the digitizer control window.  When you’re done measuring the section 
lengths, click the button on the digitizer pen or cursor that you set as the stop 
digitizing action (see Digitizer | Setup Buttons) to record the length into the 
selected Excel cell. 

For more information on printing the drawing, setting styles, and rounding lengths at 
the Digitizer Control window see About the Digitizer Control Window. 

Continuous Length 

 

The continuous length command accumulates the total length every time you click or 
trace along a line. 

To digitize continuous lines, click on a cell, and then choose Digitizer | Continuous 
Length or click on the Continuous Length button on the toolbar. 

To digitize continuous lengths simply click or trace along the line shown on the plan.  
If you are tracing, you’ll need to hold down the digitizing pointing device button 
while you drag it along the line.  If you have continuous lengths that are not 
connected, you can stop one line and start another by pressing the Enter key or by 
clicking the button on the pointing device you programmed under Digitizer | Setup 
Buttons to perform the close line/area action.  You can also use the popup menu 
button defined under Digitizer | Setup to end the line.  

To erase the last point, press the Backspace key.  You can also delete an entire line 
by selecting the Delete Selected Object command from either the popup menu set 
under Digitizer | Setup Buttons or by using the Edit menu of the digitizer control 
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window. When you’re done, click the button on the digitizer pen or cursor that you 
set as the stop digitizing action under Digitizer | Setup Buttons, press the End key 
on the keyboard or click the green check mark using your mouse to close the window 
and record the number into Excel. 

While measuring continuous lengths you can measure the perimeter lengths of arcs, 
circles and rectangles by using the popup menu, digitizer control Edit menu or 
pressing the digitizer button previously defined as arc, circle or rectangle.  To 
measure the length of arcs, click on the start and end of the arc after an initial point is 
entered and the Arc command is selected.  To measure the circumference of circles 
click on three points either clockwise or counter-clockwise around the circumference 
of the circle after the circle command is selected.  To measure perimeter lengths of 
rectangles clicking on three of the four corners either clockwise or counter-clockwise 
around the perimeter of the rectangle after the rectangle command is selected. 

Please note that the perimeter of an area measurement can be obtained by the 
following: 

a) Measure and record area measurement into an Excel cell. 

b) Move to a new cell where you want the perimeter length to be 
recorded. 

c) Click on the continuous length command and after the digitizer control 
window appears close it immediately by clicking on the green check 
mark. 

For more information on printing the drawing, setting styles, and rounding lengths 
see About the Digitizer Control Window 

Area 

 

To digitize areas, click on a cell and then choose Digitizer | Area or click on the 
Area tool found on the toolbar. 

Simply click or trace along the perimeter line shown on the plan.  If you’re tracing, 
you’ll need to hold down the point button on the pen or cursor while you drag it.  
When digitizing areas, you don’t need to return to the first point.  By pressing the 
stop-digitizing button on the pen or cursor, the area is automatically closed back to 
the first point.   

To end one area measurement in order to start a new one, press the Enter key on the 
keyboard, press the button defined under Digitizer | Setup Buttons as Close 
Line/Area or press the button previously defined as the popup menu under Digitizer | 
Setup Buttons.  To close the window and record the area measurement into Excel, 
click the button on the digitizer pen or cursor that you configured as the stop 
digitizing action under Digitizer | Setup Buttons, press the End key on the 
keyboard or click the green check mark using your mouse. 

While measuring areas, you can enter of arcs, circles and rectangles by using the 
popup menu, digitizer control Edit menu or pressing the digitizer button previously 
defined as arc, circle or rectangle.  To draw an arc, click on the start and end of the 
arc after an initial point is entered and after selecting the Arc command.  To measure 
the area of a circle click on three points either clockwise or counter-clockwise 
around the circumference of the circle after selecting the circle command.  To 
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measure the area of a rectangle click on three of the four corners either clockwise or 
counter-clockwise around the perimeter of the rectangle after selecting the rectangle 
command. 

You can subtract islands from digitized areas.  Please note the following when 
subtracting island areas: 

• If you are using a 16-button cursor, close the area by pressing the 
button defined as Close Line/Area and then press the button defined as 
Negative Area.  Please note that the digitizer action buttons are defined 
at Digitizer | Setup Buttons.  After you press the Negative Area 
button, you'll notice that the word Area on the digitizer control panel 
will be highlighted in red.  The word Area highlighted in red indicates 
that all areas will be subtracted.  When you're done digitizing the first 
island, press the Close Line/Area button to subtract the first island and 
start on the next island.  To change from subtracting areas to adding 
areas, press the Negative Area button after you closed the negative 
area.  The word Area will not be highlighted in red when Areas are 
being added. 

• If you are using a pen stylus, you'll need to use the keyboard to toggle 
on and off negative area feature.  To subtract areas, before digitizing 
the island press the minus sign on the keyboard or use the button 
defined as popup menu under the Digitizer | Setup Buttons command.  
After pressing the minus sign, you'll notice that the word Area on the 
digitizer control panel will be highlighted in red.  To change from 
subtracting areas to adding areas, press the plus sign on the keyboard 
after you closed the negative area.  The word Area will not be 
highlighted in red when Areas are being added. 

• When subtracting islands, negative areas are deducted from the positive 
areas.  The perimeter length however of the negative areas is added to 
the perimeter lengths of the positive areas to arrive at a total perimeter 
length for both the positive and negative areas. 

• Islands will always be displayed with a contrasting clear or solid fill 
pattern on the digitizer control window. 

The Area command calculates three numbers at the Digitizer Control window: the 
area, the perimeter length of the area and the number of corners or points touched.  
When you press the stop-digitizing button, the area number will be placed into the 
selected worksheet cell.  To record the perimeter measurement into a different 
spreadsheet cell, move to the desired cell and select the Continuous Length 
command and then press the stop digitizing button on your digitizer pointing device 
or click on the green check mark button immediately after the Digitizer Control 
window opens.  To record the number of points into another cell, move to a different 
cell and select the Count command followed by the stop-digitizing button. 

For more information on printing the drawing, setting line styles, setting area fill 
patterns and colors, see About the Digitizer Control Window  

Print Drawing 

 

To print your digitized drawings: 
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1. Select the cells that contain digitized values.  To select multiple cells, click on 
the first cell and then hold down the Ctrl key while you click on subsequent 
cells. 

2. Select the print command by going to Digitizer | Print Drawing or select the 
Print Drawing button on the toolbar.  

3. A Title Block Entries dialog box will open.  Here, you can enter in a project 
name, location and measurement identifier.  This information will be included 
on the digitized drawing printout.  After entering the information, click OK and 
the BidPoint XL Print Preview window appears. 

4. At the top of BidPoint XL Print Preview window several commands are found.  
By pointing the mouse pointer over the icon, a description of the command is 
displayed. Moving from left to right the following commands are available: 

• Print - prints the displayed drawing. 

• Print Setup - defines the printer and page orientation. 

• Depress when printing to a Meta or PDF file 

• Select Font – allows you to change the font of the text found on the 
printout. 

• Rotate Counter Clockwise - rotates the drawing. 

• Rotate Clockwise - rotates the drawing clockwise 

• Show Border – allows you to include an optional birder around the 
page. 

• Show Measurements – Depressing this button displays the 
measurements for the individual areas and lengths digitized. 

• Show Style Legend - If use Styles is checked under the Digitizer | 
Setup menu, depressing this button displays the style legend.   

• Select Scale – When the drawing prints, a scale for the printed drawing 
is chosen here.  This may be different than the scale used when 
digitizing the measurements.  To change the printed page scale, select 
the desired scale from the drop down list box. 

• Close Preview Form – closes the print preview window. 

Change Scale 
Change Scale lets you change the scale after you have digitized a measurement. 
You’ll use this command if you digitized using the wrong scale.   

To change a scale, click on the cell(s) that contain a digitized number with the wrong 
scale and then select this command to change the scale.  If many cells were digitized 
using the wrong scale, select the other cells by holding down the Ctrl key on the 
keyboard while you click on the desired cells.   

Change Drawing Name 
If Use Drawing Names is checked under the Digitizer | Setup menu, each 
measurement must be assigned to a drawing name.  This option lets you change 
between drawings. 
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Change Style 
If Use Styles is checked under the Digitizer | Setup menu, each measurement is 
identified by a style.  This command lets you change the style for any measurement. 

Setup 
Prior to digitizing areas, lengths and counts for the first time, you'll need to setup the 
digitizer pointer’s buttons by selecting Digitizer | Setup.    

Four tabs are displayed on the Setup dialog: 

1. Options 

2. Cursor Style 

3. Buttons (or Actions) 

4. Styles 

 

 
 

Options tab: 

 

o If Use Drawing Names is checked, you’ll name and identify the 
drawing name as you digitize measurements.  When you name 
your drawings, you’re able to show all takeoff measurements 
pertaining to the named drawing found in other cells as you 
digitize into the current cell.  We suggest that you check the Use 
Drawing Names option as, and if, the need arises. 

o The Use Styles check box enables you to create line styles, 
organized by group at the Styles tab. 

o The command template option is available when using a Numonics 
Accugrid digitizer, virtual tablet digitizer driver or an older GTCO 
brand Wintab driver.  The printed command template is placed on 
the digitizer tablet and you’ll press the Locate button to instruct the 
software where the digitizer command template is located.   You’ll 
be able to operate the BidPoint program through the attached 



18  •  Digitizer Menu and Toolbar BidPoint XL Users' Guide 

command template.  The commands found on the template can be 
easily accessed through the 16 button cursor.  As a result, the 
command template is usually used with the Numonics brand 
digitizers and the pen stylus digitizer pointer device.  

 

Cursor Style tab: 

 
 

At the Cursor Style tab, you define the type of digitizer pointer used with the 
digitizer tablet.  You can also set the digitizer buttons by clicking on the Set button 
actions to recommended values.   

Buttons (or Actions) tab: 

 
 

Select the Buttons tab to set an action and sound for each button.  

There are eleven different actions the digitizer pointing-device buttons can perform: 

1. Do Nothing.  (None) 

2. Register points and trace lines.  (Point) 

3. Stop digitizing and record the measurement into the Excel worksheet cell.  
(Stop Digitizing).  You can also use the End key on the keyboard or the 
green check mark button with your mouse to record the number into the 
Excel cell. 
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4. Close an area or end a continuous line so that you can continue with the 
next area or continuous length.  (Close Line/Area).  You can also press the 
Enter key on the keyboard to perform this action. 

5. Delete the last point entered.  (Delete Last Point).  You can also use the 
backspace key on the keyboard to perform this action. 

6. Suspend the digitizer so it will act as a mouse (Suspend).  You’ll use this 
button to turn your digitizer pointing device back into the mouse mode in 
order to select the style commands at the Digitizer Control window.  Please 
note to resume digitizing after this button is pressed, you’ll need to select 
the lightening bolt icon on the measure window. 

7. Subtract island areas.  (Negative Area).  After closing an area, by pressing 
the button noted in 4 above, pressing this button will allow you to subtract 
island areas from gross areas.  Pressing the minus sign on the keyboard can 
also activate this action.  Please note that when you're entering negative 
areas, the word Area on the Digitizer Control (Area) window will be 
highlighted in red.  To deactivate the negative area action, press this button 
again or press the plus (+) sign on the keyboard. 

8. Measure the area and perimeters of arcs by clicking on two points after an 
initial point is entered. (Arc). 

9. Measure the area and circumference of circles by clicking on three points 
either clockwise or counter-clockwise around the circumference of the 
circle.  (Circle). 

10. Measure areas and perimeter lengths of rectangles by clicking on three of 
the four corners either clockwise or counter-clockwise around the perimeter 
of the rectangle.  (Rectangle). 

11. Access the BidPoint popup menu. (Popup Menu). 

To program each button, click on the button at the top of the window and select the 
action you want the button to perform.  If you’re using a pen with only two buttons 
(tip and barrel), the pen tip will be used to Point and the side button will be set to 
either Stop Digitizing or Popup Menu.  If you're using a pen with two-barrel 
buttons, set one for Stop Digitizing and set the other for Popup Menu.  

If you’re using a 16 button cursor, the top left button is usually set to Point, and the 
upper right button is set for Stop Digitizing and you can pick whatever buttons you 
want to perform any of the other activities.   

You can also associate a sound with the button by clicking on the Sound drop down 
list box.  If you select WAV file, you’ll need to select the actual .WAV file by 
clicking on the three-dot lookup button located to the right of the box found above 
the Test button.  Often, .WAV files are found in your Media folder under the 
Windows folder.  Once a sound or .WAV file is selected, you can hear it by clicking 
the Test button. 

Styles tab: 

If Use Styles is checked at the Options tab, you’re able to create a styles legend by 
clicking the Styles tab.  The Styles are organized by Group and by using the buttons 
at the bottom of the Styles window; you’re able to create Groups and Named Styles.   
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Digitizer Info 

 

Digitizer | Digitizer Info provides you with digitizer information obtained from the 
Wintab driver.  The digitizer manufacturer supplies the Wintab driver software.  If 
you haven’t loaded the Wintab driver, no information will be found here.  You are 
unable to digitize with BidPoint XL until the Wintab driver software is properly 
loaded.   

If you ever encounter problems with the digitizer, you should click here to verify that 
BidPoint XL is recognizing the Wintab driver.  If no information is displayed, there 
is a problem with the Wintab driver software. 

For more information on hooking up your digitizer see Hooking up your Digitizer  

Digitizer Help 

 

Contains the help file for the BidPoint XL software. 
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Digitizer Control Window 

About the Digitizer Control Window 
Selecting Digitizer | Count, Section Length, Continuous Length, or Area 
commands from the Microsoft Excel menu places you into the Digitizer Control 
window.  As you digitize measurements, a drawing of what you’re digitizing is 
displayed. 

The Measure display of the Digitizer Control window displays the digitized drawing 
with measurements.  It also contains:  

• Green check-mark accept measurement tool – which records the 
measurement into Excel. 

• Red X cancel changes tool – closes the window without recording the 
number into Excel. 

• Yellow lightening bolt resume digitizing tool – is active only after the 
Suspend button is pressed on the 16-button cursor.   

The Digitizer Control window has menu options, icons and buttons.  You can use the 
digitizer-pointing device to select these commands by pressing the device button 
previously defined as suspend under Digitizer | Setup Buttons.  

Most menu commands can also be performed by using the tools found on the 
Measure, Print, Style and Round buttons on the toolbar.  

For more information, see: 

File 

Edit 

Edit 

Options 

Using the Popup Menu 

File 
The File pull-down menu on the Digitizer Control window contains the following 
commands: 

• Print command prints the displayed drawing. 
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• Print Setup is used to define the printer, paper size and page 
orientation. 

• Close (OK) shuts down the Digitizer Control window and records the 
digitized value into the spreadsheet cell.  The green check mark button 
on the toolbar at the Measure button also closes the window and 
records the measurement into the spreadsheet cell.  Normally however, 
you will close the Digitizer Control window and record the 
measurement into the cell by pressing the stop-digitizing button on the 
digitizer-pointing device.  The stop digitizing button is defined at 
Digitizer | Setup Buttons. 

• Exit (Cancel), on the other hand, closes the window without changing 
the cell value.  The red X button on the toolbar at the Measure button 
also cancels the changes. 

Edit 
The Edit pull-down menu on the Digitizer Control window has several commands.  
Many of these commands can also be selected by using the buttons on the 16 button 
cursor or by pressing the button you defined as popup menu at Digitizer | Setup 
Buttons. 

• Close Area/End Line  -  If you want to takeoff multiple areas or 
continuous lengths and have the total measurement displayed in one 
worksheet cell, press the Enter key, or Close Area/End Line 
command to close the area or continuous line measurement and start a 
new measurement.  After you select this command, you can begin 
digitizing a new area or continuous length.  When you are done 
digitizing all areas and lengths, press the pointing device button you 
configured for stop digitizing to record the measurement into the 
worksheet cell.  This command is often performed by pressing a button 
on your pointing device that was defined to close line/area at Digitizer | 
Setup Buttons. 

• Stop Takeoff – Closes the window and records the measurement into 
the Excel worksheet cell.  You can also stop the takeoff by pressing the 
End key on the keyboard or by clicking on the green check mark with 
the mouse. 

• Negative Area – After digitizing a positive area, selecting this 
command allows you to deduct areas.  When negative area is active the 
word Area on the digitizer control window is highlighted in red.  

• Arc – After digitizing one point under the Area or Continuous Length 
command, a curved line can be entered by selecting this command and 
then digitizing on the start and end of the arc. 

• Circle – When digitizing areas and continuous lengths, circles can be 
drawn and measured by selecting this command and entering three 
points along the circumference of the circle either clockwise or counter 
clockwise. 

• Rectangle – When digitizing areas and continuous lengths, rectangles 
can be drawn and measured by selecting this command and clicking on 
three of the four corners either clockwise or counter clockwise. 

• Delete Last Point - If you make a mistake while digitizing, the 
Backspace keyboard key, or Delete Last Point command, deletes the 
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last digitized point.  If you press the Backspace key three times, the 
last three digitized points are deleted from the current measurement.  
You can also press the delete last point button on the digitizer-pointing 
device.  The delete last point button is defined at Digitizer | Setup 
Buttons. 

• Delete All Points - Pressing the Home key, or the Delete All Points 
command, deletes all points pertaining to the current measurement.  
You'll use the command if you want to erase the current drawing and 
start from the beginning.  

• Delete Selected Object – Selecting this command lets you delete select 
objects using the digitizer pointing device.  The digitizing pointing 
device must not be in mouse mode when deleting selected objects. 

• Resume Drawing - If you have programmed one of the digitizer 
pointing device buttons to suspend (see Digitizer | Setup Buttons for 
more information) and you have pressed that suspend button to activate 
the mouse pointer, selecting this command turns the digitizer pointing 
device from mouse mode back to digitizing mode.  The lightning bolt at 
the Measure button on the toolbar also changes the digitizing pointing 
device back to the digitizing mode. 

Options 
The Options pull-down menu on the Digitizer Control window is where you set line 
colors, area fill styles, line styles and point styles.  These commands are also 
available to you from the Style button found on the toolbar.   

To use the menu or toolbar with the digitizer pointing device, you must press the 
digitizer button that you defined as suspend at Digitizer | Setup Buttons.  To resume 
digitizing after pressing the suspend button, click on the Return to Measuring (it 
looks like a lightning bolt) tool at the Measure button. 

The following commands are found at the Digitizer Control window Options pull-
down menu: 

• Color lets you change your drawing line color.  To select a color, move 
to the desired color, press the spacebar or click with the mouse and 
then hit the OK button.  Whatever color you select here will cause the 
font color of the highlighted cell to also change.  You can also change 
line colors by changing the Excel font color. 

• Font is where you specify the font included on the digitized drawing 
printout. 

• Fill Style allows you to select from eight different patterns for area 
measurements.  The selected pattern will be placed inside the area 
drawing. 

• Line Style lets you select from five different line styles when drawing 
areas and lengths. 

• Point Style gives you six point style options to choose from when 
digitizing counts. 

• Rounding lets you round up length measurements to a specified degree 
of precision.  Rounding up length measurements eliminates long 
numbers to the right of the decimal.  Please note that each section 
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length and each side of the polygon when calculating perimeter length 
are rounded. 

• Show Status Bar lets you hide or display the status bar at the bottom 
of the digitizer control window.  The status bar gives you digitizing 
instructions and displays the X and Y positions of the digitizer pointing 
device. 

Help 
The Help pull-down menu on the Digitizer Control window has several commands: 

• Contents presents the on-screen help organized by chapter topics. 

• Index displays the help topics index page. 

• Digitizer Info displays information about the Wintab driver. 

• Register you can register the software with Vertigraph, Inc. here. 

• About provides information about Vertigraph, Inc. 

Using the Popup Menu  
At the Digitizer Control window you can press a digitizer pointing device button to 
access the popup menu.  Which button is pressed to access the popup menu is 
defined at the Digitizer | Setup Buttons menu.  When pressing the popup menu 
digitizer button the following menu appears: 

 

• Close Area/End Line - If you want to takeoff multiple areas or 
continuous lengths and have the total measurement displayed in one 
worksheet cell, pressing this command closes the area or continuous 
line measurement so that you can begin a new area or line. 

• Stop Takeoff – Closes the window and records the measurement into 
the Excel worksheet cell.  You can also stop the takeoff by pressing the 
End key on the keyboard or by clicking on the green check mark with 
the mouse. 

• Negative Area – After digitizing a positive area, selecting this 
command allows you to deduct areas.  When negative area is active the 
word Area on the digitizer control window is highlighted in red.  
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• Arc – After digitizing one point under the Area or Continuous Length 
command, a curved line can be entered by selecting this command and 
then digitizing on the start and end of the arc. 

• Circle – When digitizing areas and continuous lengths, circles can be 
drawn and measured by selecting this command and entering three 
points along the circumference of the circle either clockwise or counter 
clockwise. 

• Rectangle – When digitizing areas and continuous lengths, rectangles 
can be drawn and measured by selecting this command and clicking on 
three of the four corners either clockwise or counter clockwise. 

• Delete Last Point - If you make a mistake while digitizing, this 
command deletes the last digitized point.  If you press the Backspace 
key three times, the last three digitized points are deleted from the 
current measurement.  

• Delete All Points - Pressing this command or the Home key on the 
keyboard deletes all points pertaining to the current measurement.  
You'll use the command if you want to erase the current drawing and 
start from the beginning.  Be careful – all drawing data will be lost. 

• Delete Selected Object – Selecting this command lets you delete select 
objects using the digitizer pointing device.    
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Other Useful Information 

Editing and Erasing your Digitized Drawings 
To edit your drawing, click on the spreadsheet cell that contains the measurement, 
and then select the type of measurement (i.e. area, section length, continuous length 
or count) from either the Digitizer menu or toolbar.  For example, if a number in a 
spreadsheet cell resulted from a digitizer area, select the Digitizer | Area command 
to view the area.  Press the Backspace key to delete points.  You can also add new 
measurements to the displayed drawing. 

You can change colors and styles when you are at the Digitizer Control window.  
From the Digitizer Control window select the Styles button on the toolbar.  You can 
also change digitized line/point colors by changing the font color in Excel.   

To move or copy digitized drawings, use the Excel cut, copy and paste commands 
found on the keyboard (Ctrl+X, Ctrl+C, Ctrl+V), Edit pull-down menu or by 
clicking the right mouse button when clicked on a cell. 

To delete digitized drawings, press the right mouse button when highlighted on the 
cell and select delete comment.  You can also delete drawings by using the copy and 
paste commands.  Copy a blank cell, then move to the cell containing a drawing and 
paste the blank cell.  Pasting a blank cell will erase the cell value and drawing 
comments.  When in the Digitizer Control window, drawings are deleted using the 
Edit menu. 

Digitizer Information and Cell Comments 
Digitizer info is stored as Excel cell comments.  If a cell contains digitizer 
information (i.e. cell comments) a red dot is found in the top right hand corner of the 
cell.  If you have digitized a drawing into a cell and do not see the comment indicator 
dot, turn the comment indicator on by selecting Tools | Options | View in Excel. 

To view a cell comment in Excel, click on the cell and press either the right mouse 
button to select show comment, or press the Shift+F2 keys.  Deleting the cell 
comment in Excel erases the drawing. 

Certain default digitizing information is stored in cell comment A1 of the 
spreadsheet.  As a result, after digitizing you will see a comment indicator appear in 
cell A1.  With BidPoint XL, you can digitize into any cell, except cell A1. 
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View Multiple Drawings  
To view and print multiple digitized drawings: 

a) Select the cells that contain digitized values.  To select multiple cells, 
click on the first cell and then hold down the Ctrl key while you click 
on subsequent cells. 

b) After the cells are chosen, select the print command by going to 
Digitizer | Print Drawing or select the Print Drawing button on the 
toolbar.  

c) A Title Block Entries dialog box will open.  Here, you can enter in a 
project name, location and measurement identifier if you like.  This 
information will be included on the digitized drawing printout.  Or just 
click the OK button. 

d) To print the drawings, select the Print command. 

Please note that the drawings are layered according to the order of selection.  For 
example, if an area with a solid fill pattern hides your count symbols, choose the area 
measurement first then the count drawing. 

Troubleshooting 

Drawing Data is Larger than Allowed Message 
Excel limits the number of points that can be recorded into any cell comment.  As a 
result, approximately 2,000 digitizing points can be entered into one cell.  It is rare 
that a digitized drawing will contain more than 2,000 points.  However, if a drawing 
does contain more than 2000 points, you will need to record the measurement in two 
different cells and use the spreadsheet functions to add the two cells together. 

At the digitizer control window, the number of points is counted while you digitize.  
The number of points digitized is affected by the manner in which you digitize: 

• Are you clicking on the corners or are you tracing the perimeter?  
Tracing lines generates many more points then clicking on the corners 
or end points of lines. 

• If tracing around a radius, the slower you trace, the more points are 
generated.  

• To reduce the number of points, try using the arc or circle commands 
for curved lines. 

Using Cell Protection in Excel 
If you are using Excel's cell protection features, do not protect the worksheet for 
objects or formatting when digitizing.  After selecting Tools | Protection | Protect 
Sheet make sure Objects is not checked.  If Objects is checked, you'll receive a run-
time error 1004 message. 
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Open a Workbook before Digitizing 
You may receive a run-time error 91 message if you try to digitize a measurement 
without having an Excel workbook opened.  As a result, make sure you have a 
workbook open before digitizing. 

The Esc Key while Digitizing Causes an Error 
If you press the Esc key on the keyboard at any time after selecting a digitizer 
command, you’ll receive a Microsoft error message that states “code execution has 
been interrupted”.  If you click the End button, you’ll have problems and will need 
to exit Excel and reopen prior to digitizing again.  As a result, always select the 
Continue button when you receive this error message instead of the End button. 

Red Comment Indicator is Not Displayed 
The digitizer information is stored as cell comments. As a result, cells that contain a 
digitized drawing will display a red dot, comment indicator in the cell.  If you do not 
see a small red dot in the top right-hand corner of the cell after digitizing, you’ll need 
to turn the comment indicator on by going to Tools | Options and select the View tab 
and select comment indicator only. 

Error Message Displayed 
If you receive an error message, please save the file and Exit MS Excel before 
digitizing again.  Please notify Vertigraph about the error message if it is not 
addressed above.  

 


